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1 Introduction 
 
This guide provides a more in depth look at the features and setup of the EL-USB-RT data logger, 
and written around software version 2.0.9.0.   
 
The EL-USB-RT is designed to work in conjunction the dedicated software, running within 
Windows 2000, XP and Vista (32-bit versions only).  There are currently no official versions of the 
software for Linux or Mac OS. 
 
2 Operation 
 
2.1 Basic software interface 
 
After installation, a new icon (two coloured blocks) should be visible in the notification area of the 
taskbar, normally in the bottom right corner of the screen.  The software will run every time the PC 
starts. 
 
Right clicking on this icon brings up the EL-USB-RT software menu.  The menu gives options to 
enable or disable monitoring, graph the current data, export to Excel and modify logging settings. 
These settings are also available from the ‘File’ menu when the main software window is open. 
 

 
 
 
When monitoring is enabled, moving the mouse over the notification icon will display the current 
readings. 
 

 
 
Selecting ‘Open Graph Data’ from the software menu opens the main page.  The current 
temperature, humidity and dew point readings are displayed here, along with a graph of recent data. 
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2.1.1 Simple view 
 
The ‘Simple View’ gives a graph of the previous minute of readings and bar graphs of the current 
readings. 
 

 
 
2.1.2 Detailed view 
 
Switching to the detailed view displays a graph of the complete session data to a maximum of 
32,000 readings (see Data storage below for further info). This view also includes maximum, 
minimum and average readings for each parameter. Whilst being viewed this graph does not 
automatically update, Click the update button  to view the latest data. 
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2.2 Data storage 
 
The EL-USB-RT does not store readings internally, but transmits the data to the host PC.  A reading 
is taken once every second, which is then compared to the previous reading.  If the readings are the 
same, the reading is then discarded.  If the readings are different, a new data entry is created.  This 
conserves file space as the data file only stores changes, rather than a reading every second. 
 
The readings are written to a temporary file that automatically saves when the capacity reaches 
32,000 entries.  The data can also be manually saved at any time by the user, via the taskbar icon or 
File menu. File size is limited to 32,000 readings, as this is the maximum number of readings that 
Microsoft Excel can display on a single graph.  Because the EL-USB-RT only records changes, 
there is no fixes duration for the file.  Typically, the file will store between four and nine days. 
 
The default location for automatically saved files is "My Documents\EL-USB-RT\".  The user can 
modify this however, by performing a manual save and picking a new location.  All future 
automatic saves will then use this location  
 
When the user attempts to shut down or log out of the PC the EL-USB-RT software will offer to 
save the current data (This feature can be disabled in the settings tab by ticking ‘No backup on 
session end’).  If the temporary file is not saved it will be overwritten when the next recording 
session starts. A backup copy of the temporary file is made, that can be used to recover the 
penultimate recording session (In the event of a power failure, or when a user forgets to save data). 
 
The temporary files that are used to store the readings can be found in a hidden directory at the 
location. 
 
C:\Documents and Settings\<user>\Local Settings\Application Data\EL-USB-RT\ 
 
Where <user> is the current logged in user name. 
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3 Settings 
 
The ‘Settings’ tab has options to configure the measurement scale (°C, °F), turn alarms on and off 
for each variable (with user adjustable thresholds) and modify email settings (see section 3.1). 
 
The threshold alarm setting for dew point allows you to set an alert to indicate that the temperature 
is getting close to the dew point, the point where the water vapour in the air will condense. 
 
Additional settings on this page are: 
 
Mute PC beep on alarm Mutes the PC speaker (By default the PC speaker will beep every 5 

seconds when an alarm condition is met). 
 
No backup on session end Disables the EL-USB-RT software prompt to save data when the PC 

is shut down or the user logs off. 
 
Enable email settings  Enables email alerts to be sent (see section 3.1). 
 
Enable Daily Activity Log Sends an email every 24 hours at midnight with the day’s data, 

including maximum, minimum and average readings for each 
parameter (email settings must be enabled). 

 
The ‘Save’ button must be pressed before any changes take effect. 
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3.1 Email 
 
The software can be configured to send email alerts (when an alarm threshold is met or exceeded) 
and daily activity logs. 
 
The daily activity logs are sent as an attachment and include the past 24 hours of data and the 
maximum, minimum and average reading for each parameter.  This data can then be imported into 
the software or excel for viewing. 
  
To use the email facilities, a POP/SMTP email account is required.  The software will not send 
emails using a Windows Live / hotmail account or Windows exchange server.  Google Mail offers a 
free email service that has POP/SMTP functionality, if one is not already available. 
  
The email alerts and daily activity log are enabled on the ‘Settings’ page of the software by ticking 
the boxes ‘Enable email settings’ and ‘Enable Daily Activity Log’. The email alerts must be 
enabled for the daily activity log to be functional. 
 
3.1.1 Email configuration button 
 
When the ‘Email configuration’ button is pressed for the first time, a wizard will guide you through 
the steps needed to setup the software to send email.  Subsequent access to the settings page will 
open the existing email settings.  The wizard can be re-run by clicking on the ‘Show wizard’ link at 
the top of the page.  Before setting configuring the email setting, the following information is 
required: 
 

• Outgoing mail server name (SMTP)    
• Outgoing mail server port number (SMTP)  
• User Name      
• Password      
• From Address      
• Enable secure connection for server (SSL) 

 
 
If you do not know this information it can be obtained from your email software (If it is a client 
based email account – please see section 3.1.2) or from your email provider (This information is 
normally available on email provider help pages).  Not all web based email accounts support POP / 
SMTP functionality (such as hotmail).  Please consult your provider directly or their help pages.  
 
Users of Microsoft Outlook and Outlook Express can import their setting directly, using the ‘Import 
SMTP settings’ button on the second page of the wizard.  The user only needs to select the email 
client and then the profile / identity (Normally ‘Main Identity’ in Outlook express) from the drop 
down lists.  The only settings that are not imported are the password and recipient email address 
(which can be the same as the sender’s email address).  The ‘Setup outgoing email server’ does not 
need modifying and can be ignored. 
 
To verify the settings, press the ‘Send test email’ button. 
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It is possible to use an SMTP server built into the EL-USB-RT software which does not require any 
email provider settings.  This is only recommended if you are experiencing difficulty using the POP 
/ SMTP method, as there are limitations with this method. 
The EL-USB-RT SMTP server mode can be selected on the settings page shown after the wizard is 
completed. 
The method works by contacting the recipients email server directly.  The limitations are as follows: 
 

• Some recipient domains, including AOL, may refuse email that originates from a residential 
gateway. 

• Some domains do not accept email from dynamic IP addresses. 
• Some mail servers employ an anti-spam technique called Greylisting. The server will reject 

incoming emails until a certain time period has elapsed, usually an hour.  
 
 
3.1.2 Locating email account settings from your email client 
 
If you use a client application to download your email, such as Microsoft Outlook or Outlook 
Express the settings you require can be obtained from the account settings page of these 
applications.  This steps are only valid for POP / SMTP type email accounts. 
 
Outlook Express 6 
 
Select the ‘Tools’ menu and then ‘Accounts…’.  Select the ‘Mail’ tab and highlight the email 
account you wish to use.  Click the ‘Properties’ button. 
The ‘General’ tab indicates the email address. Select the Server tab and make a note of the 
‘Outgoing mail (SMTP)’ and  ‘Account Name’ (User Name) details. 
To check which port is used and whether it needs to be a secure connection, select the ‘Advanced’ 
tab.  Take note of the ‘Outgoing server (SMTP)’ port number and whether ‘This server requires a 
secure connection (SSL)’ is enabled 
 
All these settings can now be entered into the EL-USB-RT software.   
 
Microsoft Outlook 2003 
 
Select the ‘Tools’ menu and then ‘Account Settings’.  The email wizard is now displayed and the 
default option ‘View or change existing email accounts’ should be selected.  Click ‘Next’ and the 
following screen will show the available accounts.  Highlight the one you wish to use and select 
‘Change…’ to view its properties. 
From the ‘Internet Email Settings’ screen, take a note of your ‘Outgoing mail server (SMTP)’, 
‘User name’ and email address.  To check which port is used and whether it needs to be a secure 
connection click the ‘More Settings’ button and select the ‘Advanced’ tab. Take note of the 
‘Outgoing server (SMTP)’ number and whether ‘This server requires an encrypted connection 
(SSL)’ is enabled. 
 
All these settings can now be entered into the EL-USB-RT software.   
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Microsoft Outlook 2007 
 
Select the ‘Tools’ menu and then ‘Account Settings’.  Under the ‘email’ tab, highlight the account 
you wish to use and click the ‘Change…’ button on the menu bar. 
From the ‘Internet email Settings’ screen take note of your ‘Outgoing mail server (SMTP)’, ‘User 
name’ and email address.  To check which port is used and whether it needs to be a secure 
connection click the ‘More Settings’ button and select the ‘Advanced’ tab. Take note of the 
‘Outgoing server (SMTP)’ number and whether ‘This server requires an encrypted connection 
(SSL)’ is enabled. 
 
All these settings can now be entered into the EL-USB-RT software.   
 
 
 
3.1.3 Common Provider Email Settings 
 
Gmail 
 
Ensure that your account is POP enabled by clicking on the settings button at the top of any Gmail 
page and then selecting click ‘Forwarding and POP / IMAP’.  The ‘Enable POP for all mail’ box 
should be ticked.  Ensure that the ‘save changes’ button is pressed before leaving the page. 
 
Gmail server details: 
 
Outgoing mail server name (SMTP)  smtp.gmail.com 
 
Outgoing mail server port number (SMTP) 465   
 
User Name     <your Gmail address, including @gmail.com> 
 
Password     <your Gmail password> 
 
From Address     <your Gmail address, including @gmail.com> 
 
Enable secure connection for server   Enabled 
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Yahoo! 
 
Not all Yahoo! domains provide free POP email access. It is freely available to www.yahoo.co.uk 
and www.yahoo.ca domains.  Other yahoo users may have to pay for a ‘Yahoo! Mail Plus’ account. 
 
If POP access is available on your Yahoo! Account, you will need to switch to the ‘Mail Classic’ 
interface to view the necessary options.  To enable POP access, log in to your account, click 
options, select ‘POP access and Forwarding’ and tick the ‘Web & POP Access’ option.  The 
interface can then be returned to normal if required. 
 
Yahoo! Mail Plus server details: 
 
Outgoing mail server name (SMTP)  plus.smtp.mail.yahoo.com  
 
Outgoing mail server port number (SMTP) 465 
 
User Name     <your email address, without the @yahoo.com> 
 
Password     <your email password> 
 
From Address     <your email address, including @yahoo.com> 
 
Enable secure connection for server   Enabled 
 
 
Yahoo.co.uk server details: 
 
Outgoing mail server name (SMTP)  smtp.mail.yahoo.co.uk  
 
Outgoing mail server port number (SMTP) 465 
 
User Name     <your email address, without the @yahoo.co.uk> 
 
Password     <your Yahoo password> 
 
From Address     <your email address, including @yahoo.co.uk> 
 
Enable secure connection for server   Enabled 
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3.1.4 Email troubleshooting 
 

• Ensure that the ‘Enable email Settings’ box is ticked in the EL-USB-RT software email 
configuration screen 

• Check that no security software is blocking the EL-USB-RT software accessing the internet 
and sending email. You may need to set a rule or open a port in you firewall software to 
allow sending of email for the EL-USB-RT software. 

• When there is an error sending an email the EL-USB-RT software generates an error.txt file.  
This file can contain useful information is diagnosing the problem.  It is located here: 
 
C:\Documents and Settings\<user name>\Local Settings\Application Data\EL-USB-
RT\error.txt 
 
Where <user name> is the name of current user profile on the PC that you are using.  The 
file is in a hidden directory.  If this directory cannot be seen, go to the ‘Tools’, ‘Folder 
Options’ menu in Window Explorer and tick the ‘Show hidden files and folders’ option. 

 
 
3.1.5 Sending Messages to Mobile Phones 
 
Many mobile phones now have email functionality.  
 
Mobile phones in North America generally have an email address which takes the form of : mobile 
phone number@carrier email address e.g. 1234567891@vtext.com Where 1234567891 =10 digit 
mobile phone number and vtext.com = carrier email address (e.g. Verizon).(carrier email address 
list). Note: Addresses may change so you need to verify them with you provider before using. In 
order to send to a cell phone you simply enter the email address (as described above) into the EL-
USB-RT software. 
 
If your mobile phone does not have email functionality, it is possible to send text messages to it by 
sending an email to a third party provider that then forwards it as a text message to your mobile 
phone.  Ensure that you keep any additional text to a minimum, to avoid exceeding the 160 
character limit of text messages. 
 
The following companies can provide this service. 
 
Connection Software  http://www.csoft.co.uk
 
Esendex Limited  http://www.esendex.co.uk
 
Clickatell   http://www.clickatell.com/solutions/business/email.php
 
TM4B    http://www.tm4b.com/
 
AtMail    http://www.atmail.com/
 
IPIPI    http://www.ipipi.com
 
BulkSMS   http://usa.bulksms.com
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3.2 Export Data to Excel 
 
Data can be exported to Microsoft Excel by selecting the ‘Export data to Excel’ option from the file 
menu in the main software or by right clicking on the taskbar notification menu icon 
 
3.3 Saved Data 
 
The ‘Saved Data’ tab shows any automatically saved data files.  Files can be added to this list by 
using the ‘Browse’ button. Select ‘Plot Data’ to view the data of any files added to the saved data 
list. 
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